
Contents for Message Center

Message Center lets you read and write both private and public electronic correspondence.    

General Concepts
What is E-mail? 
What are Forums? 

Main Windows
Message Center 
Reading a Message 
Writing a Message 
Spell Checker 

Offline, On Deck, and Online
You need to be online when getting new messages and when sending messages you've 
written.    To read messages directly from the Worldgroup server's Post Office and from online
forums, you need to remain online.

Alternatively, you can copy mail from your Post Office to your In Box, and you can make 
offline copies of forum messages as well.    Once you have local copies, you can read them 
regardless of whether you are online or offline.    

When you write messages, you can record them in the Out Box on your PC and they will not 
be transmitted to the Worldgroup server until you explicitly send    them.    You do not need to
be in contact with the server while composing messages.    

As installed, Message Center waits for you to order it to check for new mail.    Optionally, you
can set Message Center to periodically check the Worldgroup server for new mail.    You can 
further set it to go online if necessary in order to make those checks, or set it to check only 
while you are online.    



What is E-Mail?

Electronic mail is a powerful and efficient way to send detailed messages to individuals who 
need not be there when the message arrives.    Messages can also deliver attached 
document or program files, a major improvement over transferring files by floppy disk or 
copying them to some shared archive in hopes that the intended recipient will see them.    

SMTP (simple mail transfer protocol) has been a staple of Internet activity for years.    At the 
same time, LAN-based mail systems such as those based on Novell's MHS have been equally
important within company walls.    The two areas evolved independently, however, and have 
only recently started to share messages with each other.    

Worldgroup provides the same e-mail service whether users connect to a Worldgroup server 
through the Internet's TCP/IP, in-house TCP/IP, Novell IPX/SPX, dial-up modem, dial-up ISDN, 
even X.25 packet-switched networking for international service.    Worldgroup also 
exchanges mail with Internet/Intranet SMTP hosts and Novell MHS systems.    When you 
connect to a fully configured Worldgroup server, you can exchange messages with people 
across the world.

See also Contents and E-mail addresses 



What are Forums?

Forums are typically long-term conversations.    One user will start a topic of discussion by 
posting a question or a comment (I feel this way about X.... How does everyone else feel 
about it?).    Other users will read the message the next time they are online on this server.    
Some will reply to the message.    Replies to replies may continue over a period of weeks or 
months, the thread of conversation often becoming many hundreds of messages long.    

Threads are valuable sources of information even if you don't wish to participate in the 
debate.    You'll read all sides of an issue and gain a much fuller understanding from it.    In a 
technical support forum, for example, a thread might start with one user describing a 
problem she's having by posting a request for advice.    She may get 17 responses that night,
some of them contradictory.    There may well be more than one solution to the problem, and
even the wrong ones can show what not to do.    By the next night, others will have chimed 
in to naysay the inaccurate suggestions.    

Forums are similar to Usenet Newsgroups, but rather more organized and much more user 
friendly.    In particular, forums when accessed through Worldgroup Manager more sensibly 
handle the uploading and distributing of files attached to publicly posted messages.    
There's no need to wonder where you can find the proper decoding utility.    Files travel from 
one user's standard Windows Attach/Open dialog box to the forum, then down to other 
users' standard Windows Download/SaveAs dialog boxes.    

You can explore forums in a fully-online or in a batch-offline mode.    If online time is not 
expensive to you, you can either select and browse a particular online forum, or you can    
scan multiple forums for particular keywords, new messages, etc.    

If online time is    expensive to you, however, you can make local copies of messages which 
interest you, disconnect from the Worldgroup server, then read those forums offline.    

See also Contents and e-mail addresses



Message Center

The Message Center window displays lists of various types of messages which you can read 
and optionally reply to.    To change the window to view In Box messages, Post Office 
messages, etc., either click the corresponding toolbar button or pull down the List menu and 
select which list you wish displayed.

Pulldown Menus
File Menu for Message Center 
List Menu for Message Center 
View Menu for Message Center 
Options Menu for Message Center 

Display Area
The bar immediately beneath the toolbar indicates whether the currently displayed 
list of messages represents your In Box  ,   your Post Office box, a Forum with 
Thread Listed, or a file Folder  .      
Date
The date this message arrived on the Worldgroup server, no matter whether this 
message is still on the server (Post Office) or has been copied to your PC (In Box).    
From
The User-ID or e-mail address of the person who sent this message.    
Topic
The topic (Re:) of the message, optional.    
To
When displaying messages in your file folders, this is the person to whom this 
message is addressed.    
Thread
When displaying messages in a forum, this is the equivalent of the Topic field.    
Msgs
When displaying messages in a forum, this is the number of messages in each 
thread.
Excerpt
When displaying messages in a forum, this is the first few characters of text from 
each message in the highlighted thread.

Toolbar
Check for New Mail
Checks the Post Office at the Worldgroup 
server to see if new messages have 
arrived addressed to you.    Same as the 
File menu's Get New Mail.    
Delete Message
Deletes the currently highlighted 
message.    Same as pressing the Del key.
Write E-mail Message
Lets you compose a new message and 



either immediately send it or place it in 
your Out Box for sending later.    Same as 
the File menu's Write E-mail.    
Post in Forum 
Lets you create the first message in a new
thread in the current forum.    Same as the 
File menu's Post in Forum.    
Show In Box
Changes the main window to display mail 
messages you've copied from the 
Worldgroup server's Post Office.    Same as 
the List menu's In Box.    
Show Post Office
Changes the main window to display mail 
messages stored on the Worldgroup 
server.    You can copy them to your local 
In Box.    Same as the List menu's In Box.    
Select Forum
Lets you select an online forum then read 
its messages.    Same as the List menu's 
Forum.    
Select Offline Forum
Lets you make local copies of forum 
messages, then read and reply to them 
offline (on deck).    Same as the List 
menu's Offline Forum.
Scan Forums While Online
Takes you online and lets you scan for 
messages in all available forums.    You can
either read them online or tag them for 
download to be read offline.    Same as the 
List menu's Scan.
Open Folder
Lets you manage messages saved for 
future reference.    Same as the List 
menu's Folder.    
Jump to the first message in this list.
Jump to a specific message in this list.
Jump to the last message in this list.
Manage Address Book
Lets you edit or add User-IDs and e-mail 
addresses to your Address Book.    Same 
as the View menu's Address Book.    
Manage Distribution Lists
Creates and manages lists of e-mail 
addresses for sending mass mailings.    
Same as the View menu's Distribution 
Lists.
Show Out Box
Lets you examine and manage all 
messages which you have written but 
which have not yet been sent to the 
server.    Same as the View menu's Out 
Box.    
List Messages



When the Message Center window is 
displaying forum messages, this lists all 
messages within the current forum in 
chronological order.
List Threads
When the Message Center window is 
displaying forum messages, this lists all 
messages within the current forum sorted 
by threads (topics) so you can examine 
individual conversations.    
You Have New Mail
Appears at logon if you've configured your
Mail Options to notify you at logon when 
the Post Office at the Worldgroup server 
has new messages addressed to you.    
Same as the File menu's Get New Mail.    

Message Icons
E-mail message
with Return Receipt
with Priority
with Return Receipt & Priority
with Attached File
with Attached File & Return Receipt
with Attached File & Priority
with Attached File & Return Receipt & Priority
E-mail Message Already Read by You
with Attached File, Already Read by You
Forum Message Not Yet Read By You
with Attached File, Not Yet Read By You
Forum Message Already Read By You
with Attached File, Already Read By You



File Menu for Message Center

Get New Mail
Begins downloading all mail addressed to you which has accumulated at the server 
since your last request for download.    This menu selection will immediately take you 
online if you are not already online.    

Open
Displays the text of the currently highlighted message.    

Delete
Erases the currently highlighted message, without    asking if you are sure.    In the 
case of In Box messages, if the original message is still in the Post Office, you can tag
and get it again.    

Write E-mail
Lets you address then compose a private message to be delivered solely to the 
individual(s) you name, then either send it or place it in your Out Box for sending 
later.    

Post in Forum
Lets you select a forum, then lets you compose a public message to be posted in that
forum where anyone with sufficient access may read it.    You may either address the 
message to an individual (as a response to a comment he or she posted previously) 
or to all users.

Tag Message
Appears when you are viewing the contents of your Post Office box or an online 
forum.    Each message listed in the Post Office and in online forums has a checkbox 
to its left.    When checked, this message has been tagged for future reference.    
When unchecked, this message is left untagged.    You can toggle a message between
tagged and untagged by using this menu option, by single-clicking the checkbox with
your mouse, or by pressing the space bar key on your keyboard.    

You can also tag entire threads by their threadnames while listing an online forum.    
To do this from the menus, pull down the Thread menu and select Tag.    The keyboard
and mouse actions are the same for both kinds of tagging, however.    

Clear Tags
Appears when you are viewing the contents of your Post Office box or an online 
forum, and is dimmed if no messages have been tagged (their checkboxes checked).  
This menu option unchecks the checkbox to the left of every message in the currently
displayed list (Post Office, a particular forum, etc.).    

Get Tagged
Appears when you are viewing the contents of your Post Office box or an online 
forum, and is dimmed if no messages have been tagged (their checkboxes checked).  

If the currently displayed list is an online forum, this menu option gets every tagged 
message for offline use, then untags (unchecks the checkbox of) every message 
gotten.    This is handy when you wish to rapidly browse forums while you are online 



with your Worldgroup server, copy entire threads or individual messages which at 
first glance catch your interest, then disconnect from the Worldgroup server and read
those messages on deck.    

If the currently displayed list is your Post Office, this menu option copies every 
tagged message into your In Box, then untags (unchecks the checkbox of) every Post 
Office message gotten.    This is particularly handy when you access your Worldgroup 
server from more than one end-user computer (perhaps one at home as well as one 
at work, perhaps a portable while on the road).    From one computer, you can initially 
get new mail, read it, perhaps reply to it, then go to the Post Office (located on the 
server) and tag any messages you'll want to get once you reach the other computer.   
Later, from that other computer, you can List your Post Office messages and tag the 
ones you want to get.    

Exit
Closes this module and returns control to the application which launched it.    



List Menu for Message Center

In Box
Changes the main window to display mail messages you've copied from the 
Worldgroup server's Post Office.    

Post Office
Changes the main window to display mail messages stored on the Worldgroup server. 

Forum
Brings up a list of all forums known to be available on the Worldgroup server.    When 
you select one, the server sends you header information (topics, etc.) for messages 
in that forum.

Offline Forum
Lets you get forum messages from the Worldgroup server and keep them on your PC 
for later reading/replying while offline.    If you have already gotten messages, this 
brings up the list of forums represented by those messages.    

Scan
Lets you select a set of forums and search conditions (keywords, message age, etc.), 
then goes online to find all messages which match.

Folder
Stores and organizes permanent copies of messages you write and messages you 
receive.    

Temporarily stores messages which you've gotten from the server so that you can 
read them offline and on deck.    



View Menu for Message Center

Jump to
Handy when browsing through long lists of messages, this selection brings up a 
cascading menu which lets you jump to either the First message in the list, the Last 
message, or a Specific message identified by message number.

Address Book
Manages a list of User-IDs and e-mail addresses entered either manually or 
automatically by lifting them from messages, then lets you use them to more easily 
address messages you write.    

Distribution Lists
Creates and manages lists of e-mail addresses for sending mass mailings.    

Out Box
Temporarily stores messages which you've written while on deck.    When you've 
finished writing messages, a single button click sends the messages to the server.    

Toolbar
Activates or deactivates the button toolbar.    The option of editing which buttons 
appear in this toolbar is located in the Options menu.        



Thread Menu for Message Center

List
Gets heading information from the Worldgroup server for every message in the 
selected thread in this forum. then lists those messages on the right-hand side of the 
Message Center window.    The far simpler way to do the same thing is to double-click 
on the thread's descriptive text.    

Tag
Each thread listed when displaying online forums in thread view has a checkbox to its
left.    When checked, it means that this thread has been tagged for future reference.   
When unchecked, this thread is left untagged.    You can toggle a thread between 
tagged and untagged by using this menu option, by single-clicking the checkbox with
your mouse, or by pressing the space bar key on your keyboard.    

You can also tag individual forum messages while listing an online forum in either 
thread or message view.    To do this from the menus, pull down the File menu and 
select Tag Message.    The keyboard and mouse actions are the same for both kinds of
tagging, however.    



Forum-Op Menu

This menu and its selections appear only to the appointed operator of each forum.    Regular 
users won't need to consider any issues covered in this menu.    If for some reason you can 
access these options but suspect this system's management probably didn't intend for you 
to, please tell them by private e-mail (User-ID Sysop), a page, or a telephone call as soon as 
you can.    You're standing on a sidewalk at night, looking through the accidentally open door 
of an empty office.    If you go further, you won't be breaking in, but you certainly will be 
trespassing.    

Manager
Runs a separate client app to manage forums.    

Set User Access
Sets an individual user's level of access to this forum (read but not download, read 
but not post, post but not upload, etc.).    To set access for an entire class, select 
Manager.    

Copy User Access
Copies an individual user's level of access to another individual.    



Options Menu for Message Center

You can customize Message Center's operation to better suit your needs.

Mail
Sets how you want the In Box and Post Office to react when new or tagged mail 
appears.

Write
Sets defaults formatting choices like ruler dimensions, tabs, spell-checking, whether 
to assume plain or rich text, whether to quote by default, etc.

Fonts
Sets default fonts and sizes for plain and rich text, display of plain-text messages 
received, etc.

Out Box
Sets whether to immediately send messages from the Out Box upon connecting to 
the Worldgroup server, prompt you, or not send until you manually click Send.

Server
Most options are set locally on your PC's hard disk.    Some, though, must be recorded
on the Worldgroup server.    Although this dialog box can come up without first going 
online, in order to save changes you make here you will have to go online.

Edit Toolbar
Lets you edit Message Center's toolbar.    You can turn off buttons you don't use, later 
restoring them if you wish.

List
Appears only when the currently displayed list is that of a forum.    
Threads
Causes the current list of forum messages to be displayed on your screen sorted by 
thread name, letting you more easily see the flow of a particular conversation 
separate from all of the other unrelated messages which were posted at about the 
same time.    
Messages
Causes the current list of forum messages to be displayed on your screen sorted by 
date and time of posting, regardless of thread name.    You can still follow a thread of 
conversation while reading a message by using the View menu's Thread To 
selections.    
Unapproved
This option is not displayed unless this Worldgroup server's management has 
appointed you as a forum operator.    Access to a particular forum can be handed out 
bit by bit.    At the extreme bottom, a particular user may not have any access to a 
particular forum at all.    Next up, he may be able to read messages in that forum yet 
not be able to download any files attached to those messages, and not be able to 
post his own messages.    Somewhat higher in the access levels, a user may be able 
to post messages to a forum, and be able to upload files to be attached to those 
messages, yet those attached files won't automatically be available for download to 



other users.    Those files must first be approved by the forum's operator.    This menu 
option, visible only to ForumOps, brings up a list of all messages in the current forum 
which have unapproved files attached to them.    The Forum-Op can then approve 
them for others to download.    In many cases, files are automatically approved for 
download so this issue is avoided altogether.    



In Box

There are two ways to handle electronic mail and forums: online and on deck.    

Users who run Worldgroup Manager primarily from one PC will usually copy Post Office 
messages into their local In Boxes.    Once they have local copies, they can log off, read 
those messages, and write replies while on deck.    They may choose to delete original 
messages from the Post Office once they've copied them to the In Box, or they may leave 
Post Office messages to be automatically erased by the Worldgroup server after whatever 
number of days the system administrators have set for message lifetimes.

Users who alternate between PCs (office PC and home PC, perhaps a notebook on the road) 
will usually read and reply to their mail right in the Post Office so that messages can be 
accessed no matter what end-user equipment they use to reach the central Worldgroup 
server.    Even if the only access is through terminal mode, users can still get to their Post 
Office messages.

To make the Message Center window display your In Box's contents, go to the List menu and
select In Box.    



Post Office

When mail addressed to your User-ID arrives on the Worldgroup server, it is placed in what 
amounts to a Post Office Box associated with your user account.    Whenever you go online, 
the Worldgroup server notifies you if the Post Office has new mail for you.    

Users who alternate between PCs (office PC and home PC, perhaps a notebook on the road) 
will usually read and reply to their mail right in the Post Office so that messages can be 
accessed no matter what end-user equipment they use to reach the central Worldgroup 
server.    Even if the only access is through terminal mode, users can still get to their Post 
Office messages.

Users who run Worldgroup Manager primarily from one PC will usually copy Post Office 
messages into their local In Boxes.    Once they have local copies, they can log off, read 
those messages, and write replies while on deck.    They may choose to delete original 
messages from the Post Office once they've copied them to the In Box, or they may leave 
Post Office messages to be automatically erased by the Worldgroup server after whatever 
number of days the system administrators have set for message lifetimes.

To make the Message Center window display your Post Office's contents, go to the List menu
and select Post Office.    



Select a Forum

You can use Forums in a fully-online or in a batch-offline mode.    

If online time is not expensive to you, you can either select and browse a particular online 
forum (done here) or you can    scan multiple forums for particular keywords, new messages,
etc.    

If online time is    expensive to you, however, you can make local copies of messages which 
interest you, disconnect from the Worldgroup server, then read those forums offline.    

This lets you set one forum as the current forum so that you can read its messages and 
optionally write replies to them.    

To reach this window, go to Message Center's List menu and select Forum.    

Show Forum Groups / All Forums
There are often thousands of users on a single Worldgroup server posting messages 
on various subjects in Forums.    One way to keep Forums from becoming an area of 
chaos is to create separate forums, each named for some relatively narrow subject of
discussion.    A business might have forums named Announcements from 
management to employees, Social from employees to each other, Comments from 
employees to management, etc.    An entertainment system might have forums 
named New Movies, Australian Rules Football, etc.    

A large Worldgroup system may end up with a hundred or more forums.    To keep 
forums themselves organized, sysops often group related forums.    The 
entertainment example above might have a Theatre group and a Sports group, each 
containing relevant forums.    It is possible for a single forum to belong to more than 
one group, by the way.    If there's a Spectator group, for example, it might include 
forums discussing both live theatre and stadium sports events.    

Name
The name of each available forum.    

Description
A brief description of each available forum.    

Highlight the forum you wish to select and click OK.    Alternatively, just double-click the 
forum.    



Offline Forum

You can use Forums in a fully-online or in a batch-offline mode.    

If online time is not expensive to you, you can either select and browse a particular online 
forum, or you can    scan multiple forums for particular keywords, new messages, etc.    

If online time is    expensive to you, however, you can make local copies of messages which 
interest you, disconnect from the Worldgroup server, then read and reply to the local copies 
offline.    

This window displays the names of all forums currently represented by local copies of 
messages.    If the list is empty, it means there are currently no local copies of forum 
messages on your PC.    Normally, when this list is empty, you are asked if you wish to get 
messages.    

OK
Assuming the main part of this window displays at least one forum name, this returns
you to the Message Center window which will list the local copies of messages 
previously gotten from this forum.    

Cancel
Closes this window and returns you to the Message Center window as it was before 
you opened this window.    

Get
This lets you select forums and other settings, then gets local copies of those 
messages for offline viewing/replying.

Clear All
This erases all local copies of messages from all forums previously gotten.    

Clear Read
This erases local copies of all messages you've read so far.    This is particularly handy
for paring down a large collection of messages gotten once but read over several 
offline sessions.    



Get Messages for Offline Use

This lets you set which forum messages to get from the server.    

To reach this window, go to the List menu and select Offline Forum.    If your PC does not    
contain any offline copies of forum messages, youll be asked if you want to get messages, 
so click Yes.    If your PC does    already contain offline copies of forum messages, youll be 
presented with a list of those forums.    Click Get to get new messages for offline use.

Get which messages
You can select to get tagged messages or run a search for messages which match the
criteria you specify in Setup.    
Tagged messages
This is dimmed until you tag messages.    
Results of a scan
You decide what criteria to search for through Setup  .      

Options
Disconnect when done
To minimize the amount of time spent online, check this box.    You can move on to 
other Windows applications, or walk away from your PC.    When the last message has
been downloaded, the Forums client app will automatically go offline and back to on 
deck.    
Include attachments
One or more of the messages you get may have files attached.    There's no way to 
predict how large these files may be (i.e., how much online time it will take to 
download them).    If online time is expensive for you, leave this box unchecked and 
only the messages will be downloaded.    Once offline (on deck), you can read the 
messages to determine whether downloading the file(s) is worthwhile.    You can then 
build a list of such files to be downloaded in the Download Manager.    
Download to
This is dimmed until the Include attachments checkbox is checked.    You can 
manually enter the drive:\path to which you want to save attached files, or click 
Select.    
Select
This is dimmed until the Include attachments checkbox is checked.    It lets you select 
the drive:\path graphically instead of typing it in manually.    



Scan Setup

This lets you select criteria you wish to use when scanning for forum messages.    

To reach this window when getting messages for offline use, pull down Message Center's List
menu, select Offline Forums, click Get, then click Setup.    

To reach this window when scanning for messages while remaining online, go to the List 
menu and select Scan.    

Keywords
A keyword can be an entire word or the beginning of a word.    Searching for one 
entire word is the most rapid way to search by keyword, and is the most likely to find 
something.    

You can use the following symbols and words to combine more than one keyword, but
be aware that combination searches can take a very long time to tell you that nothing
matched the combination of keywords:

and & Searches for messages 
which contain both 
keywordA and keywordB.    
Same as using a Space: 
keywordA    keywordB
This will also find 
occurrences of keywordB    
keywordA.    You can reduce 
search time by putting the 
less common word in first 
place.    

or ¦
(pipe)

Searches for messages 
which contain either 
keywordA or keywordB, plus 
those which contain both.

xor ^ Searches for messages 
which contain either 
keywordA or keywordB, but 
do not contain both.    

not ! Searches for messages 
which do not contain 
keywordA

( ) ( ) Forces the search to resolve 
the keyword or combination 
within the (parentheses) 
before resolving the rest of 
the keyword string.    

A side-effect of symbol logic is that you cannot search for occurrences of the words 
and, or, xor, and not.    

Starting message #
You can limit how far the search will reach into the past by entering here a relatively 



recent message number.    Messages whose numbers are lower than this number will 
not be included in the search.    

Show only
New messages
If this box is checked, the scan will include only messages which you have not 
already read (those which have been posted to Forums with message numbers higher
than the highest-numbered message you've read to date).    
Messages with attachments
If this box is checked, the scan will include only messages which have files attached 
to them.    
Messages to you
If this box is checked, the scan will include only messages which have been 
addressed to you individually.    Messages addressed to **ALL** will not be included.    
Messages from you
If this box is checked, the scan will include only messages which have been sent by 
you.    

Select Forums
Chooses which forums will be scanned for messages matching the above criteria.    

Save
Records the current settings and will present these settings in future when you bring 
up this window.    

Clear
This erases the Keywords field, unselects all forums, and sets Starting message # to 
zero.    



Select Scan Forums

You can use Forums in a fully-online or in a batch-offline mode.    

If online time is not expensive to you, you can either select and browse a particular online 
forums (done here) or you can    scan multiple forums for particular keywords, new 
messages, etc.    

If online time is    expensive to you, however, you can make local copies of messages which 
interest you, disconnect from the Worldgroup server, then read those forums offline.    

This lets you set one or more forums so that you can read their messages and optionally 
write replies to them.    

To reach this window, go to Scan Setup and click Select Forums.    

Name
The name of each available forum.    

Description
A brief description of each available forum.    

OK
Accepts all forums currently highlighted and returns you to Scan Setup.    

Select
Highlights (or unhighlights) the forum named in the type-in field above the list of 
forum names.    The simpler way to select forums is to scroll down the list and single-
click the ones you wish to include.    Highlighted means the forum will be included in 
the scan.    Not highlighted means it will be ignored.    

All
Highlights every forum in the list.    

Clear
Removes the highlight from every forum in the list.    

Details
Displays more information about the currently selected forum.    



Open Folder

This lets you store permanent copies of messages you write and messages you receive.    You
can create folders in which to keep messages sorted.    

To reach this window in order to read messages already filed, go to the Message Center 
window's List menu and select Folder.    

To reach this window in order to file the message you're currently reading, go to the Reading 
a Message window, pull down its File menu and select File it.    

OK 
If you arrived at this window in order to read messages already filed, clicking OK 
changes the Message Center window to display a list of all messages filed in the 
currently highlighted folder.    If you arrived at this window in order to file the 
message you're currently reading, clicking OK files the current message in the 
currently highlighted folder.    

In both cases, double-clicking a folder name has the same effect as highlighting that 
folder name then clicking OK.    

Cancel
Closes this window and does not select a folder.

Add
Adds a new folder to the filing cabinet.    

Edit
Lets you rename the folder.

Delete
Erases a folder and all of the messages contained within it.    It does ask if you are 
sure first.    The (General) folder cannot be deleted.    



Create New Folder

This lets you add a new file folder to the Filing Cabinet.    

To reach this window, go to the Open Folder window and click the Add button.    

Folder Name
Type in the name you wish to give this new folder and press Enter (or click OK).    



Rename Folder

This lets you rename an existing file folder.

To reach this window, go to the Open Folder window and click the Edit button.

Folder Name
The current name for this folder is displayed and selected.    Type in the new name 
you wish to give this existing folder and press Enter (or click OK).    



Manage Address Book

This lets you maintain a list of User-IDs and/or e-mail addresses so you don't have to 
remember that, for example, IN: docs@gcomm.com is the address for 
suggestions/complaints/comments about WGM's help documentation.    

To reach this window, go to Message Center's View menu and select Address Book.    

Add
Creates a new entry in your address book.    

Edit
Edits the currently highlighted entry in your address book.    Alternatively, you can 
double-click on an address entry to edit it.    

Delete
Removes the currently highlighted entry from your address book.    This occurs 
immediately without asking if you are sure; there is no Undo.    



Add Which Address?

This window appears when the program cannot tell which address you wish to add to your 
Address Book.    

To reach this window, read a forum message whose To: and From: address fields are different
from each other and are neither **ALL** nor your address.    

Highlight the address you wish to add to the Address Book and click OK.    Alternatively, 
double-click on the address you wish to add.    



Address Book Entry

This lets you create a new entry in your address book, or examine or change an existing 
entry.    

To create a new entry, go to the Manage Address Book window and click Add.    To change an 
existing message, go to the Manage Address Book window, highlight the entry you wish to 
edit, then click Edit.    Alternatively, double-click the entry you wish to edit.    

Name
This is the person's spoken name, job title (like Sales), ... whatever term is most 
meaningful to you.    The text you write here will not be attached to any message.    
Only the Address field's information is used in messages.    

Address
This is the official User-ID (for a recipient who is a member of this Worldgroup) or e-
mail address (for a recipient on a system beyond this Worldgroup).    

The Find button helps you look up a User-ID on this Worldgroup.    It cannot help you 
locate e-mail addresses for systems outside this Worldgroup, however.    The 
Electronic Mail world does not have anything comparable to the United States Postal 
Service or the telephone companies to provide a master list of addresses, so it's up to
each individual online service to manage its own list of users.    

One way to gather e-mail addresses is to be told them: most people know their own 
addresses and so can tell them to you over the phone, printed in a letter, etc.    

Another way to gather e-mail addresses is to clip the From: field from messages 
mailed to you.    

Comments
This lets you record any other information such as voice telephone number, the 
person's birthday, names of family members, the person's job specialty, etc.    

While it's still wise not to commit to writing any comment you might later come to 
regret, the text you record here will not be attached to any message you send unless 
you expressly use Cut (Ctrl+X) or Copy (Ctrl+C) commands to duplicate or copy some
of these Comments into the body of a message.    

This field will also accept Paste (Ctrl+V) for clipboard text cut or copied from 
elsewhere.    

Carriers
If this Worldgroup server is isolated (that is, does not exchange messages with other 
message-carrying systems like the Internet, Novell MHS, MajorNet, etc.), this button 
will not appear.    

If this Worldgroup is attached to other messaging systems, you can send messages to
people on those other systems by addressing them in the form

Prefix: e-mail address

The window which appears when you click Carriers lists the available messaging 



systems and the prefix letters you need to type ahead of the e-mail address.    For 
example, to send an e-mail message to the user docs at the Internet site gcomm.com
you type in an address of

IN: docs@gcomm.com



About E-mail Addresses

This Worldgroup may, or may not, provide access to users on other systems beyond its own 
local membership.    If it does, this Worldgroup can be a gateway through which you can 
exchange e-mail with people on those other systems.    Corresponding with people outside 
this Worldgroup is not quite the same as corresponding with members on this Worldgroup, 
however.    

User-IDs
This is how members of one Worldgroup identify themselves when interacting with 
other members in the same Worldgroup.    A User-ID is a human-friendly identification:
most systems allow you to use your full name including spaces, or a nickname if you 
prefer.    

When you exchange e-mail or forum messages with members of this Worldgroup, you
address them by their User-IDs.    You can use Find to search for the correct spelling of
a User-ID because this Worldgroup naturally has a complete list of all members' User-
IDs.    You cannot use Find to search for people who are not members of this 
Worldgroup because this Worldgroup has no way of knowing the complete path to the
other user.    

Imagine handing a letter to a mailman with an address of John Hunt and no further 
information.    Unless the mailman knows someone who answers to that name, he has
no way to deliver it.    The mailman is comparable to a single Worldgroup: you can 
send messages to other members of this Worldgroup simply by User-ID because the 
program knows its membership by name.    

Now imagine handing a letter to a mailman with a full mailing address: John Hunt at 
Galacticomm, Inc., 4101 SW 47th Avenue Suite 101, Fort Lauderdale, Florida 33314.    
Does this mailman personally know where this is?    Almost certainly not.    But he 
does know where his local post office is located.    It in turn knows where to send all 
mail with zipcodes beginning in 333, that hub knows where to send mail with zipcode 
33314, and that post office has people who know where 4101 SW 47th Avenue Suite 
101 is.    Finally, someone in Suite 101 knows who John Hunt is.

E-mail Addresses
This is how members of one online service identify themselves to members of other 
online services.    An e-mail address is a machine-friendly identification: it is most 
often an arcane-looking string of symbols and syllables like IN: docs@gcomm.com    

If you send a message to this address, your Worldgroup will have no idea who docs is,
and probably won't know exactly where gcomm.com is, either, but it will know how to
send messages to the INternet (assuming this Worldgroup has access to the Internet -
some few still do not).    The machine which receives this message from your 
Worldgroup server will in turn pass it on to other systems until it reaches gcomm.com
which, finally, will place it in the Post Office box of user docs.    

When you exchange e-mail or forum messages with persons who have not signed up 
as members of this Worldgroup, you will need to address them by their official e-mail 
address so that the equipment between the two of you will know how to deliver the 
message.    



Plain Text Messages
Persons who are members of this Worldgroup and who run Worldgroup Manager on 
their Windows PCs, they will be able to receive rich text formatted (RTF) messages 
with embedded colors, fonts, styl  e  s  , sizes, and so forth.    

Persons who are not members of this Worldgroup, though, or members who are 
reading messages in terminal mode, will see only fixed pitch ASCII text.    When 
posting to Usenet newsgroups or mailing to IN:e.mail@ddresses, write the messages 
in plain text to be sure what you mean to send is in fact what you do send.    

Internet E-mail Addresses
The Internet is a worldwide Inter-network.    It's the most popular, and so far the most 
powerful, way for online services to exchange information with each other.    The 
person you're writing to may be a member of another Worldgroup, or may be on 
some completely different online service.    So long as both your system, and his or 
her system, have Internet access, you'll be able to reach that person by using an 
Internet e-mail address of the form:    

IN: internet.user.name@domain.name

Your own Internet User Name
Assuming this Worldgroup server has Internet access, you can receive messages from
users anywhere on the planet.    But first, you need your own Internet user name.    

Your Worldgroup User-ID most likely won't work as it is.    For one thing, it's common 
for User-IDs to contain spaces, and Internet addressing sees spaces as separators.    
On the other hand, periods are acceptable in place of spaces.    Worldgroup makes the
two naming conventions work with each other by swapping spaces for periods.    

For example, if a person goes by the User-ID Elizabeth Hunt, she automatically has an
Internet user name of elizabeth.hunt        

To exchange messages with people beyond her Worldgroup, though, she needs to 
specify which    the domain name of her Worldgroup.    Domain names describe 
networks and individual computers within the Internet.    For example, Galacticomm's 
domain name is gcomm.com      (the .com indicates that ours is a commercial site as 
opposed to educational, governmental, etc.).    

Your Internet user name, an @ (Shift+2), and the domain name of your Worldgroup 
server, form your Internet address.    A person receiving a message from 
elizabeth.hunt@gcomm.com knows not only who she is but where she looks for 
incoming messages.    Give your Internet address to anyone you would like to be able 
to write you Internet mail.    

Other Online Services
Some large online services such as CompuServe and America Online allow users to 
exchange messages over the Internet, but insist that their Internet addresses be 
variations on their internal User-IDs.    



CompuServe E-mail Addresses via the Internet
To send a message to a CompuServe user over the Internet, you'll need to use an 
address of the form:    

IN: xxxxxx.yyyy@compuserve.com

where xxxxxx.yyyy is the person's CompuServe account number.    Notice that, 
internally, CompuServe uses a comma to separate xxxxxx from yyyy but the Internet 
addressing system doesn't accept commas, so a period is used instead.    

For example: CompuServe user 76556,3647 can be reached through the Internet via 
IN:76556.3647@compuserve.com 

America Online E-mail Addresses via the Internet
To send a message to an America Online user over the Internet, you'll need to use an 
address of the form:    

IN: username@aol.com

where username is the AOLuser's name, all lowercase, no spaces.    



Address a Message

This lets you look up an address from your address book, from distribution lists, or from 
forums, and insert that address in the To and/or cc: fields of this message.    

To reach this window, from the Writing a Message window click the Address a Message 
button alongside the To: and cc: fields.    

(dropdown menu)
What kind of address are you looking for?    From this dropdown menu you can choose
to look in your Address Book for an individual's address, in Distribution Lists for the 
name of a particular list, or for the name of a forum you wish to make a public 
posting to.    

Copy
Once you've selected an address, you can copy it to either the To or the cc: fields.    
Note that you can copy more than one address to the cc: field.    The upper limit to 
the number of carbon copies you are allowed to send of a particular message is set 
by the Sysop of each Worldgroup system.    

Find
Alternatively, if the person you're writing to is a member of this Worldgroup, you can 
look up his User-ID by clicking Find alongside either the To: or the cc: fields.    If this 
person is not a member of this Worldgroup, however, Find will not locate him or her.    
You will need to get that person's e-mail address by some other method.    

Details
This provides information about the item you've selected from the dropdown menu 
above.    In the case of an Address Book entry, Details will display the entry including 
comments.    In the case of a distribution list created by you, Details will display that 
list.    In the case of a distribution list created by the Sysop, Details will only show you 
the cost for using that list, if meaningful.    In the case of a forum, Details will display 
information about that forum.    

Carriers
If this Worldgroup server is not attached to internetwork message exchange systems 
(the Internet, Novell MHS, MajorNet, etc.), this button will not appear.    

If this Worldgroup is attached to such internetwork systems, you can send messages 
to people on remote systems by addressing them in the form

Prefix: e-mail address

The window which appears when you click Carriers lists the available messaging 
systems and the prefix letters you need to type ahead of the e-mail address.    For 
example, to send an e-mail message to the user docs at the Internet site gcomm.com 
you type in an address of

IN: docs@gcomm.com



Available Carriers

This lists any internetwork connections (the Internet, Novell MHS, MajorNet, etc.) through 
which your local Worldgroup can exchange e-mail and forums with other online services.    

To reach this window, go to the Address a Message window or the Address Book Entry 
window and click Carriers.    If your Worldgroup server does not exchange messages with any
remote systems, the Carriers button will not appear.    

In order to address a message to a user on one of the listed systems, go to the To: or cc: 
field of the message and type the listed Prefix followed by the user's e-mail address.    

Details
This displays information on the currently highlighted carrier, including a sample 
address and a general description.    You can reach the same window by double-
clicking any item on the list of carriers.    

(Note: plain text messages)
Persons who are members of this Worldgroup and who run Worldgroup Manager on 
their Windows PCs, they will be able to receive rich text formatted (RTF) messages 
with embedded colors, fonts, styl  e  s  , sizes, and so forth.    

Persons who are not members of this Worldgroup, though, or members who are 
reading messages in terminal mode, will see only fixed pitch ASCII text.    When 
posting to Usenet newsgroups or mailing to IN:e.mail@ddresses, write the messages 
in plain text to be sure what you mean to send is in fact what you do send.    



Manage Distribution Lists

Distribution lists allow you to mass-mail a single letter to several people at once - just 
address the message to the distribution list and the E-mail client program will send a carbon 
copy to each person on that list.    

Some distribution lists may be supplied by the Sysop of this Worldgroup for common groups:
@SALES, @MFG, @MKTG, @ENGNRING, etc.    Any list beginning with an @ sign is a Sysop-
defined list.    If such lists appear in the Distribution Lists area of Address a Message, you 
may use them when writing messages.    

One caveat: if this Worldgroup system charges for messages sent, be aware Sysop-defined 
lists may have a surcharge above the per-addressee charge.    

You can create lists of your own, and edit them as your needs change.    A list you    create 
here in Worldgroup Manager does not exact a surcharge when you use it.    Of course, you're 
still charged per addressee for everyone on the list.    

So Message Center can differentiate between a User-ID and a personal distribution list, 
whenever you type a personal list into either the To or the cc: field of a Writing a Message 
window, type LIST: in front of the list's name.

New
Creates a new distribution list.    

Edit
Changes the list of User-IDs and/or e-mail addresses in the currently highlighted 
distribution list.    

Delete
Erases the currently highlighted distribution list after asking if you're sure.



Create New List

This lets you create a new distribution list.    

To reach this menu, go to the Manage Distribution Lists window and click New.    

List Name
Type in the name you wish to give this new distribution and press Enter (or click OK).  
You'll be taken to Edit List. 



Edit List

This lets you change which User-IDs and/or e-mail addresses will be sent messages when 
this list's name is placed in the To field.    

To reach this menu, go to the Manage Distribution Lists window and double-click the list you 
wish to edit.    You also reach this window when you create a new list.    

OK
Saves changes you've made while this window was open.

Cancel
Abandons any changes you've made while this window was open.    

Add
Includes a new User-ID/e-mail address in the list.    

Edit
Renames the currently highlighted User-ID/e-mail address.    Alternatively, you can 
double-click on the address you wish to edit.    

Delete
Erases the currently highlighted User-ID/e-mail address.    This occurs immediately 
without asking if you are sure; there is no Undo.    

Import
Opens a text file you specify.    That file should contain a list of valid mailing 
addresses, each separated by a carriage return (new line):
User-ID
/forumname    User-ID
User-ID
User-ID
IN:email@domain.name
User-ID
MHS:wg@worldgrp {wg:User-ID}
etc.
Distribution lists cannot include other distribution lists.

Export
Saves the current distribution list to a text file you specify.    That file will receive each
address in the current list, each separated by a carriage return (new line).



Edit Address in List / Add Address to List

This lets you add or correct a User-ID / e-mail address in a distribution list.    

To add an address to a distribution list, go to the Edit List window and click Add.    To edit an 
address in a distribution list, go to the Edit List window and click Edit.    

Address
You can either type one in from memory or click the Address a Message button.    

 
This brings up your Address Book and lets you insert an address from its entries.    



Out Box

This is a temporary holding place for messages which you have written or forwarded but 
have not yet sent to the server.    

The Message Center client application lets you spend most of your correspondence time 
offline (on deck).    You only need to go online to send already-completed messages.    
Especially if you pay by the minute for online line, it's to your benefit to be on deck as much 
as possible.    

To reach this window, go to the View menu and select Out Box.    

Destination
This either says

(Forward) if it's a message you received and are forwarding/copying to someone else,
or 

(E-mail) if it's a message you wrote and are sending privately    to the individuals you 
named in the To and cc: fields, or 

The name of a forum if it's a message you wrote and are posting publicly    for all 
users to see, whether you addressed it to one individual or all, or

(Modify) if it's a message you already posted to a forum but are now changing and 
reposting, or

To
The User-ID or e-mail address to which you addressed this message.    It is common to
address forum messages to individuals even though they are being posted for all to 
see. 

To assure yourself that a message is being sent privately only    to the named 
individual, look in the Destination column.    If the destination is (E-mail) or (Forward), 
the message will be sent privately.    If the name of a forum appears there, the 
message is about to be posted in public.    If the destination is (Modify), the message 
has already been posted in public and is about to be updated with the changes you 
just made.

Topic
The topic (Re:) of the message, optional.    

Date
The date you first saved this message to your Out Box.    Once you send a message, 
this date is forgotten in favor of the date it arrives on the server.    

Status
Sending Now
This message is in the process of being uploaded to the server.    Only one message 
will have the Sending Now status at any time.    Once this message is sent, the next 
message with Waiting to Send status will be promoted to Sending Now.    
Waiting to Send



This message is waiting to be promoted to the Sending Now status.    Clicking Send All
converts the status of all messages to Waiting to Send.    The first Waiting to Send 
message will immediately switch to Sending Now.    
Holding
This message is not currently being sent, nor is it about to be sent, until you manually
send it by clicking Send All or by highlighting it and clicking Send.    Depending on 
your Preferences, simply going online to the server may cause these messages to 
switch to Waiting to Send.    
Being edited
This is a message you've saved to the Out Box but have since brought back into the 
Writing a Message window.    

Edit
Lets you make changes to the currently highlighted message which you previously 
saved to your Out Box but which has not yet been sent to the server.    If the 
message's Destination is (Forward), Edit brings up the Forward Message window.    If 
Destination is (E-mail) or a forum name, Edit brings up the Writing a Message window.
Double-clicking on a message in the list also invokes this Edit function.

Delete
Erases the currently highlighted message from your Out Box and so never sends it.    
This occurs immediately: it does not ask if you are sure and there is no Undo.    

Send
Sends the currently highlighted message to the Worldgroup server.    This will 
immediately take you online if you are not online already.    

Send All
Sends all messages in the Out Box to the Worldgroup server.    This will immediately 
take you online if you are not online already.    

Hold
Demotes the currently highlighted message from either the Sending Now or the 
Waiting to Send status to the Holding status.    If you double-click on a message while 
it is not in the Holding status, it will be demoted to Holding and you'll be taken to edit
that message.    

Close
Closes the Out Box window but does not    delete any messages.



Reading a Message

This one window lets you read messages in the In Box on your local PC, in the Post Office on 
your Worldgroup server, in forums, or in the file folders also on your local PC.    The title bar 
of this window will reflect what kind of message is being displayed.    

Pulldown Menus
File Menu for Reading a Message 
Edit Menu for Reading a Message 
View Menu for Reading a Message 
Options Menu for Reading a Message 

Display Area

Date
The date this message arrived on the Worldgroup server, no matter whether this 
message is still on the server (Post Office) or has been copied to your PC (In Box).    
From
The User-ID or e-mail address of the person who sent this message.    
To
This is the person to whom this message is addressed.    
Topic
The topic (Re:) of the e-mail message, optional.    
Thread
When displaying messages in a forum, this is the equivalent of the Topic field.    
Msgs
When displaying messages in a forum, this is the number of messages in each 
thread.

Toolbar
Reply only to From 
Take this message's From field and make it the 
To field of a new message but do not attempt to
lift any user-IDs from a cc:list in this message's 
body
Reply both to From & cc:list 
Take this message's From field and make it the 
To field of a new message.    Further, look for a 
cc:list in this message's body and use it to fill in
the cc: field of the new message (very useful for
workgroup discussions)
Forward 
Duplicate this message, leave its From field as 
the original sender, but change its To field to 
some third individual to whom you wish to pass 
on this message.    
Resend



Duplicate this message, change its From field to
your user-ID, and bring the duplicate into the 
Writing a Message window so you can send it. 
Delete the currently displayed message.
File it
Save to File
Print
Clip Address
Display the previous message in this list.
Display the next message in this list.
Jump to the first message in this list.
Jump to a specific message in this list.
Jump to the last message in this list.
Return to the message from which you began 
following this forum thread.
Switch to the previous thread in this forum.
Display the previous message written to this 
forum thread, not necessarily the message that 
inspired the message you are now reading.
Backtrack to Parent
If this button is active, it means that the 
message you're now reading is a reply to some 
previous message and that previous message is
still available on the Worldgroup server.    
Clicking this button brings up that previous 
message.    
Display the next message written to this forum 
thread, not necessarily a reply inspired by the 
message you are now reading.
Switch to the next thread in this forum.
Message Notes
Attach a private note from you to yourself about
this e-mail message, comparable to scribbling a
note on a paper letter you've received.    The 
pencil on this button indicates that a note is 
already present.

 Download Attachment
If a file is attached to this message, this 
downloads the file to your PC.



File Menu for Reading a Message

Reply
If you mean to reply solely to the person who wrote this message, select this choice.   
It brings up the Writing a Message window pre-addressed to the person who wrote 
the message you are now reading, but it does not attempt to lift user-IDs from any 
cc:list in this message's body.    

Reply to All
If you mean to reply to the person who wrote this message, and also copy your reply 
to anyone else named in that first message's cc:list, select this choice.    It brings up 
the Writing a Message window pre-addressed to the person who wrote the message 
you are now reading, but it also scans the bottom of that message's text looking for 
cc: and, if found, attempts to copy any addresses found there into the cc: field of 
your reply.    This is a wonderful time saver when you're in a workgroup environment 
(needing to keep all team members up to date on all activities), but it is definitely not
the right choice when you mean to respond privately to the one person who wrote 
this message.    

Forward
Sends this message on to a third person, optionally with a comment from you, 
optionally erasing your copy of the message.    

Resend
Brings up the Writing a Message window pre-addressed to the person to whom the 
message you are now reading was addressed.    This is particularly handy when you 
need to send the same basic letter(s) on demand.    Store them in one of your folders 
to be retrieved when next you need to send them.

Delete
Erases the currently highlighted message, without    asking if you are sure.    In the 
case of In Box messages, if the original message is still in the Post Office, you can tag
and get it again.    In the case of offline forums, this does not delete the original 
message from the server.    

File it
Copies this message into a folder for future use.    This also lets you copy already-filed
messages from folder to folder.

Save As
Saves the plain text of this message to a file on your PC, optionally appending this 
message to an existing file.    You can also highlight the section of text you're 
interested in and Copy it, then Paste it into some other Windows application.    The 
Copy/Paste method does transfer rich text to Microsoft Word and other programs 
which can save rich text format (.RTF) files.

Print
Prints the currently displayed message to the default printer you chose in Windows' 
Control Panel.    This menu selection is dim if there is no message currently displayed. 

Download



If a file has been attached to this message, this downloads the file to your PC.

Return To List
Closes this module and returns control to the application which launched it.    



Edit Menu for Reading a Message

Most text boxes within Message Center, especially those which display message body
text, can be selected.    That is, by placing the mouse cursor at one location in the 
text, holding down the mouse button and moving the mouse, you can highlight an 
area of text which can then be cut or copied.    In text blocks which accept keyboard 
typed input, you can paste text from the Windows Clipboard to the text cursor's 
current position.    

Copy
Without erasing the selected text, this places a copy of it on the Windows Clipboard.   
From there the text can be pasted into other Windows programs.    This menu 
selection remains dim until you select an area of text.    

Select All
This highlights all text in the current text box (where the cursor is currently located).

Clip Address 
Brings up your Address Book and lets you add the To or From address to your Book.    

Find
Searches for a particular string of text in the currently displayed message.    To search
for a particular string of text throughout multiple forum messages, go back to the 
Message Center window and Scan using Keywords.    



View Menu for Reading a Message

Next
If more than one message is in this list (your In Box, your Post Office, the result of a 
forum scan, etc.), this replaces the currently displayed message with the next one in 
the list.    It is dimmed whenever there is no next message.

Previous
If more than one message is in this list (your In Box, your Post Office, the result of a 
forum scan, etc.), this replaces the currently displayed message with the previous 
one in the list.    It is dimmed whenever there is no previous message.

Jump
Handy when browsing through long lists of messages, this selection brings up a 
cascading menu which lets you jump to either the First message in the list, the Last 
message, or a Specific message identified by message number.

Backtrack
Looks for and, if found, displays the message which inspired the current message.    

Return from Thread
Stops following the thread (conversation with same topic) and returns you to the first 
message you read in that thread.    

Notes
Attaches to this message a private note from you to you, comparable to scribbling a 
handwritten note onto a paper letter for your own future reference.    This is especially
handy when you then file the message (and its attached note) in a file folder.    

Toolbar
Activates or deactivates the button toolbar.    



Options Menu for Reading a Message

Edit Toolbar
Lets you edit the Reading a Message window's toolbar.    You can turn off buttons you 
don't use, later restoring them if you wish.

Highlight URLs
Uniform Resource Locators (URLs) like      http://www.gcomm.com      are the 
addressing scheme of the World Wide Web.    When Worldgroup Manager is running 
alongside a Web browser such as Netscape Navigator, Message Center can command
the Web browser to get the Web page at the other end of a particular URL.

By leaving this menu option checked, you tell Message Center to turn any URLs it 
finds in message text into clickable hot spots.    One mouse click on a URL and your 
Web browser will immediately begin getting that Web page.

You can disable both the highlighting and the clickability of URLs by removing the 
check from this menu option.

URL Color
By default, Message Center will highlight URLs in blue.    Each user is able to change 
that color.

Reflow
If this is not checked, message text is displayed as it was stored on the server: as 
lines of up to 72 characters with carriage return (Enter) characters embedded at the 
end of each.    

If this is checked, message text is reflowed to more reasonably fit the text box in 
which you are now reading it.    Windows Help files reflow in a similar manner: adjust 
the frame of this Help window and you'll see how the text of the paragraph you're 
now reading reflows to fit the changed space.    



Find Text in Message

Searches the text of the current message for the phrase you type here.    If you want to 
search across multiple forum messages, Scan using Keywords.    

To reach this window, from the Reading a Message window pull down the Edit menu and 
select Find.

Find What
Type here whatever fragment, word, or phrase you wish to locate in the text of this 
message.    The less you type here, the greater the chance of finding a match.

Match Case
When this box is checked, Find looks for text matching not just spelling but also 
capitalization.    When this box is not    checked, Find pays no attention to 
capitalization.

Direction
From the current position of the cursor, should Find search Up (towards the beginning
of the message) or Down (towards the end)?    



Personal Notes

On every e-mail message in either your In Box or file folder, you can attach a private note 
from you to you, comparable to scribbling a handwritten note onto a paper letter for your 
own future reference.    

If you later file this message (either from your In Box to a file folder or from one folder to 
another), this note will follow this message to its new home.    

If you later reply, resend, or forward this message, this note will not be transmitted.    In fact,
if you print this message or save it to text file, again this note will not follow it.    The intent 
of notes is to let you candidly say what you need to say about particular messages without 
fear that your words will reach others.    

If you need to write notes which you will want to forward, print, save to text, etc., write 
separate e-mail messages.    You can, of course, cut and paste from this window, so you can 
lift the text of a copious note and copy it elsewhere if needed.    

To reach this window, from the Reading a Message window pull down the View menu and 
select Notes.

To:, From:, Topic:
These are reminders of which message you're writing (or later reading) a note about.  
Notes are not ever mailed.    They are not replies.    They are private "scratchpad" 
areas within your own PC's disk space.    

Typing area
Type here whatever information you wish to remember later about this message.

OK
Saves the text of this note alongside this e-mail message, whether it is in your In Box 
or in one of your file folders.    



Write Message Header

Both e-mail and forum messages consist of a header, a body, and optionally an attached file.
The body is the conversational text, while the header is the addressing information and 
handling instructions.    In terms of snail mail, the header is the information on the envelope.

You can bring up this window from several locations.    From the Writing a Message window 
pull down the View menu and select Message Header.    From the Message Center window 
pull down the File menu and select either Write E-mail or Post in Forum.    From the Reading a
Message window pull down the File menu and select Reply or Resend.    

Valid addresses
Valid addresses fall into four categories:

User-IDs (typed as-is including spaces)

Exported e-mail 
addresses

(CArrier:user.id@host.name)

Forum names (/forumname    optional User-ID)

Distribution lists (@Sysop-defined    or    LIST:personal)

To
The address to which you wish to send this message.    You can either type one in 
from memory or click the Address a Message button.    

If this is an e-mail message, the To field will deliver this message privately    to the 
person named here, privately    to the persons itemized in a distribution list named 
here, or publicly    to the /forumname entered here.

If this is a forum message, the forum name has already been selected. so the 
contents of the To field will appear on a single message posted in that forum.    If you 
type @staff in a forum message's To field, for example, one message will be posted to
that forum indicating that it is addressed to @staff but that list will not    be used to 
send copies of this message.

cc
Messages may be sent To one address yet carbon-copied to others.    You can send a 
carbon copy to more than one address by separating them with semi;colons.    

If you specify a User-ID or exported e-mail address here, the carbon copy will be sent 
as an e-mail message regardless of whether the main message is sent by e-mail or 
posted to a forum.    

If you specify a distribution list here, carbon copies will be sent to each address in 
that list as e-mail messages, again regardless of whether the main message is e-mail 
or forum.

If you specify a /forumname optional-User-ID here, a forum message will be posted to
that other forum name.



 
Brings up the Address a Message window and lets you insert a User-ID or e-mail 
address from its entries.    

Topic
This is the equivalent of a Re: line in a printed memo.    This brief description will 
appear in the recipient's In Box list.    

Attachment
Messages can deliver files as well as body text.    E-mail messages deliver files 
privately    to individuals, while forum message post files publicly for anyone with 
access to download.
Path
Specify the drive:\directory\filename.ext as the file exists on your PC.    It will be 
copied, not removed, when the message is sent.
Select
This lets you browse your PC to locate the file.    
Name
If the filename.ext as it exists on your PC is less than meaningful to those about to 
receive the file, you can type here a more meaningful filename.ext.    Don't try to 
specify drive:\directory here.    The recipients will do that when they download the file.

Options
Depending on how you arrived at this window, some of these fields may be dimmed.   
If you select Post in Forum from the Message Center window, for example, you're 
presumably intending to make this message Public.    The Public/Private radio buttons 
will thus be dimmed with the Public button selected.    
Return receipt
E-mail messages to User-IDs on this Worldgroup can provide return receipts.    When 
the recipient gets the message from his Post Office, an e-mail message is 
automatically sent back to you telling you that the message has been received.    
Exported e-mail messages and forum messages do not support return receipts.
Priority
E-mail messages to User-IDs on this Worldgroup can be marked as priority, causing 
them to stand out when the recipient lists his mail.    Most exporters of e-mail 
messages do not support priority marking.
Show recipients
When the cc: field contains one or more addresses and this box is checked, a list of 
recipients (To and cc:) will be appended to the end of the body text of the message.    
When either the cc: field is empty or the Show recipients box is not checked, no list 
will be appended.    
Use quoting
If this message is a reply to a message you've just been reading, you can copy the 
body text of that message into the body text of this reply.    Each quoted line will 
begin with two significant characters of the original sender's address followed by a 
greater>than sign.
Plain-text
If this box is checked, you will produce a message whose body contains simple ASCII 
text.    This is preferable when posting messages to forums which echo to Usenet 



newsgroups, and when writing e-mail to users of non-Worldgroup systems because 
you'll have a clearer idea of how the message will appear to them.

If this box is not    checked, you will produce a message whose body contains rich    
text as used by such word processors as Microsoft Word (.RTF files).    Rich text can 
include embedded colors, fonts, styl  e  s  , sizes, and so forth.    

If this message is received by someone running Worldgroup Manager's Message 
Center, the message will present itself using the closest matching fonts and 
formatting.    If this message is received by a terminal-mode user or a person on a 
non-Worldgroup system, the rich text commands will have been stripped from the 
message.    

You can, by the way, cut and paste plain text to and from Wordpad, Notepad, etc., 
and you can cut and paste rich text to and from Microsoft Word.    Keep in mind, 
though, that the body text area is meant to deliver messages, not novels.    Attach 
large documents as file attachments using the message body as explanatory text.    

If the recipient of your file uses Worldgroup Manager to download the attachment, 
the Download Manager provides the option of launching the file upon arrival.    Most 
Windows setups have a file association between the extension .doc and Word.    When
WGM's Download Manager is told to launch a .doc file, it runs Word and commands 
Word to open the .doc file.    See the help file for Worldgroup Manager for more 
details.    
Public/Private
A public message will be posted in a public forum regardless of whether an 
individual's User-ID has been specified in the To field.    A private message will be sent
only to those individuals you specify in the To and cc: fields.
File when sent in (foldername)
If this box is checked, as you send this message to the Worldgroup server, a file copy 
will be made and recorded in the folder you specify here.    If this box is not checked, 
as the message is sent, no file copy will be made.    To set the default value for this 
box and the folder it suggests, see auto-file.    

Writing a Message 
Once you've set the message header information, OK takes you to compose the body
text.



Writing a Message

This one window lets you write e-mail messages to private individuals or public messages to 
all users who can view the forum you just selected.    The title bar of this window will reflect 
what kind of message is being written.    

Edit this message's header information
File Menu for Writing a Message 
Edit Menu for Writing a Message 
View Menu for Writing a Message 
Format Menu for Writing a Message 
Options Menu for Writing a Message 

Display Area

To
This is the person to whom this message is addressed.    
Topic
The topic (Re:) of the message, optional.    

Toolbar
Send this message immediately to the 
Worldgroup server which will then route it to the
To address
Save this message in the Out Box for sending 
later
File it in one of your file folders
Insert text from an existing text file (use cut 
and paste to exchange rich text with programs 
like Microsoft Word which manipulate rich text)
Save to Text File
Print
Undo
Redo
Cut
Copy
Paste
Although it's possible to paste into a message a
page or so of rich text format from, say, 
Microsoft Word, keep in mind that the body text 
area is meant to deliver messages, not novels.   
Attach large documents as files.    
Delete
Select All
Find
Replace
Signature
Inserts the most recently saved signature text 
at the current location of the cursor.    To save 
highlighted text as a signature, pull down the 



Edit menu, select Signature, then select Save.    
Spell check the message
Reflow the text of the message
Edit the header information for this message 
(To, cc:, Topic, etc.).    Note that this button's 
icon changes to reflect the current status of this
message: e-mail versus forum, return receipt, 
priority, etc.



File Menu for Writing a Message

Send
Immediately uploads the message and attached file (if any) to the server.    It will take
you online if you are not online already.    

Out-Box
Stores the message in your Out Box so you can send it later.    It will not take you 
online if you are currently on deck.    

File it
Copies this message into a folder for future use.    This also lets you copy already-filed
messages from folder to folder.

Insert
Imports a file of either plain or rich text (.RTF) into the body of this message.

Save As
Saves the plain text of this message to a file on your PC, optionally appending this 
message to an existing file.    You can also highlight the section of text you're 
interested in and Copy it, then Paste it into some other Windows application.    The 
Copy/Paste method does transfer rich text to Microsoft Word and other programs 
which can save rich text format (.RTF) files.

Print
Prints the currently displayed message to the default printer you chose in Windows' 
Control Panel.    This menu selection is dim if there is no message currently displayed. 

Cancel
Closes this module and returns control to the application which launched it, 
abandoning any changes which have not been either sent or held over in the Out 
Box.    



Edit Menu for Writing a Message

Most text boxes within Message Center, especially those which display message body text, 
can be selected.    That is, by placing the mouse cursor at one location in the text, holding 
down the mouse button and moving the mouse, you can highlight an area of text which can 
then be cut or copied.    In text blocks which accept keyboard typed input, you can paste text
from the Windows Clipboard to the text cursor's current position.    

Undo
Undoes the last change you made.    

Redo
Restores the change you just undid.

Cut
This removes the selected text and places it on the Windows Clipboard from which it 
can be pasted into other Windows programs.    This menu selection remains dim until 
you select an area of text.    

Copy
Without erasing the selected text, this places a copy of it on the Windows Clipboard.   
From there the text can be pasted into other Windows programs.    This menu 
selection remains dim until you select an area of text.    

Paste
This places the contents of the Windows Clipboard into this program at the cursor's 
current location.    This menu selection remains dim until you place text on the 
Windows Clipboard by cutting or copying it from the E-mail client program or some 
other Windows application.    A text box will not accept graphics, so if the Windows 
Clipboard contains anything apart from text, Paste will remain dimmed.    

Although it's possible to paste into a message a page or so of rich text format from, 
say, Microsoft Word, keep in mind that the body text area is meant to deliver 
messages, not novels.    Attach large documents as files.    

Delete
Has the same effect as pressing the Del key: any selected (highlighted) text will be 
deleted or, if no text is selected, the character to the right of the cursor will be 
deleted.    

Select All
This highlights all text in the current text box (where the cursor is currently located).

Find/Replace
Searches for a particular string of text in the currently displayed message and 
optionally replaces it with another string.    To search for a particular string of text 
throughout multiple forum messages, go back to the Message Center window and 
Scan using Keywords.    

Signature
Saves whatever body text is currently highlighted, then lets you add that text back 



into messages you write in future.    Most often used to append a consistent signature
or tag line at the end of messages you write.    For example, --Jack Alvrus
Save
This is dimmed until some text in the message body is highlighted.    Selecting Save 
then records that text for use by...
Add
This inserts the most recently saved signature text at the current location of the 
cursor.    

Check Spelling
Analyzes all text in this message, bringing any spelling errors it identifies to your 
attention.    This version of Message Center has been hardcoded with a spelling 
dictionary for American English.    



View Menu for Writing a Message

Header
Brings up a window with the message's To address, Topic field, whether it's plain text 
or rich, etc.    This is the same window you generally encounter immediately before 
bringing up the body text entry window.

Toolbar
Activates or deactivates the button toolbar.    

Format Bar
Activates or deactivates the format toolbar (font, size, etc.).    

Ruler
Displays or hides the horizontal ruler.    



Format Menu for Writing a Message

Font
Changes the current font, size, etc., of any selected text or, if none is selected, sets 
what font, size, etc., the next text typed will be.

Paragraph
Changes margin indentation and justification.

Tabs
Sets the locations of tab stops across the body text window.

Reflow
This lets you reassemble lines of text separated by carriage returns into one 
unbroken paragraph with a single carriage return at the end.



Paragraph Format

Indents
Left
This sets the width of the margin between the left side of the page and the left side 
of this paragraph's text.    
Right
This sets the width of the margin between the right side of the page and the right 
side of this paragraph's text.    
First line
This further adjusts the indent of the first line of this paragraph's text relative to the 
Left indent.    To produce a hanging indent (like the title word Indents above the 
words you are now reading), set the paragraph's First line indent to a negative 
number.    

To produce a paragraph indent, set the paragraph's First line indent to a positive 
number.    

Alignment
Left
This causes all lines in this paragraph to align themselves along the left margin.    
Centered
This causes all lines in this paragraph to align themselves along the center.    
Right
This causes all lines in this paragraph to align themselves along the right margin.    
Justified
This causes all lines in this paragraph to stretch so that each line is aligned along 
both the left and right margins.    



Tab Setup

Position
This field lets you type in a measurement from the left side of the page in order to set
a tab at that location.    The list beneath this field displays all currently declared tab 
stops.    

Type
Left
This aligns the text following the TAB character so that its first character is located at 
the tab stop.    
Centered
This aligns the text following the TAB character so that its width is centered at the tab
stop.    
Right
This aligns the text following the TAB character so that its last character is located at 
the tab stop.    
Decimal
This aligns the text following the TAB character so that its first period character is 
located at the tab stop.    Columns of numbers, especially currency, are much more 
legible when aligned along their decimal points.    

Set
Sets the tab stop highlighted in the list to the Position typed in above and to the 
alignment selected under Type.    

Clear
Erases the tab stop highlighted in the list.    

Clear All
Erases all tab stops in the list.    



Options Menu for Writing a Message

Edit Toolbar
Lets you edit the Writing a Message window's toolbar.    You can turn off buttons you 
don't use, later restoring them if you wish.



Word Not Found in Dictionary

Message Center can check your spelling (using an American English dictionary).

To spellcheck a message while writing it, pull down the Writing a Message window's Edit 
menu and select Spell Check.    To automatically spellcheck all messages prior to sending 
them, pull down Message Center's Options menu and select Write Options.    

Not Found
This is the word or phrase that the spell checker could not find a direct match for in 
either the standard or custom dictionaries.    

Replace With
This is the word or phrase that, if you click Replace, will be inserted into your 
message's text in place of the Not Found value.

Suggestions
By default, the Spell Options are set to automatically suggest near matches for the 
Not Found value.    If you turn off that option, you'll need to click the Suggestions 
button to invoke a search through the dictionaries for near matches.

Ignore
Leaves the Not Found value as-is and continues checking the text.    If it encounters 
this same questionable word later in the text, it will again bring it to your attention.

Ignore All
Just like Ignore except that, if it encounters this same questionable word later in the 
text, it will not    bring it to your attention again.

Replace
Replaces the Not Found value with the Replace With value and continues checking 
the text.    If it encounters this same questionable word later in the text, it will again 
bring it to your attention.

Replace All
Just like Replace except that it immediately searches the entire text for other 
occurrences of the Not Found value, replacing them all with the Replace With value.

Prompt Replace
Immediately searches the entire text for other occurrences of the Not Found value, 
but asks you each time if you wish to replace each occurrence with the Replace With 
value.

Options
Lets you fine tune the search logic of the spell checking program.

Add To Custom
Once you declare a Custom dictionary in Options, clicking here adds the Not Found 
value to your custom dictionary so that it will    be found in future.

Cancel Spellcheck
Abandons the search, leaving in place any changes made so far.    





Spell Options

Automatic Suggestions
When this box is checked, the spell checker will automatically look for near-matches 
in both the standard and the custom dictionaries for any Not Found phrase 
encountered.

When this box is not checked, the spell checker won't look for near matches until you 
click Suggestions on the Word Not Found in Dictionary window.    

Exact Match Required
When this box is checked, the spell checker is at its most sensitive, objecting to any 
word not precisely matching an entry in either the standard or the custom dictionary. 

When this box is not checked, the spell checker will accept differently capitalized yet 
same-spelled words as identical.    

Ignore Full Caps
When this box is checked, words composed entirely of CAPITAL letters will be ignored.
This is handy when you use lots of acronyms like TCP/IP in your messages.    

When this box is not checked, the spell checker will    examine words composed 
entirely of CAPITAL letters.    Remember, you can save commonly used acronyms to 
your custom dictionary.    

Ignore Partial Numbers
When this box is checked, words containing digits will be ignored.    This is handy 
when you use terms like 14th, 4Q96, and 2.4gig a lot in your messages.

When this box is not checked, the spell checker will    examine words containing 
digits.    A fairly common typing error is to press 8 when you mean to press i.    

Ignore Pure Numbers
When this box is checked, words composed entirely of digits will be ignored.    

When this box is not checked, the spell checker will    examine words composed 
entirely of digits.    

Allow Joined Words
When this box is checked, each part of a hyphenated-type word is evaluated 
separately.

When this box is not checked, hyphenated-type words are evaluated as single words. 

Recheck Typed Replaces
When this box is checked, the spell checker double-checks when you type your own 
Replace With text for a Not Found value.

When this box is not checked, the spell checker does not double-check your manual 
changes.    



Open/Close Custom
Loads/unloads a custom dictionary, including/ignoring its contents when spell 
checking.    To create a custom directory, type here the name of a file which does not 
yet exist, using extension .DIC.    The next time you run the spell checker and tell it to 
record an unrecognized word in the custom dictionary, the file you name here will be 
created and that word will be the first entry placed into it.    Further entries will be 
added as you instruct.    

Custom dictionaries are text files.    The format is very simple: one word per line 
(word, carriage return, word, carriage return, etc.), and can be created by any text 
editor such as Wordpad or Notepad.    Each word appearing in a custom dictionary is 
assumed to be a correct spelling of that word.    

Open/Close Standard
Loads/unloads the standard dictionary (American English), including/ignoring its 
contents when spell checking.

Performance vs. Memory Usage
Fast spellchecks consume resources.    This scroll bar lets you find a comfortable 
balance between your desire for speed and your system's memory capacity.

Suggestion Search Limit
The lower this value, the fewer near matches the spell checker will attempt to find for
a Not Found value.



Electrowebsterphobia: the dread fear of spell-checking programs.    



Mail Options

Sets how you want the In Box and Post Office to react when new or tagged mail appears.    

To reach this window, go to Message Center's Options menu and select Mail.    

In Box
Get new mail upon connect
If this box is checked, as soon as you are both running Message Center on your PC 
and online with your Worldgroup Server, Message Center will query the Worldgroup 
server to see if any new mail has arrived.    If there is new mail, it will be 
automatically copied to your In Box.    If no new mail is on the server, Message Center
acts as if it had not checked.    The "There is currently no new mail for you at the Post 
Office" dialog box appears when you either manually attempt to Get Mail or when you
use the NEWMAIL command string when launching Message Center.    

If this box is not checked, in order to copy mail to your In Box you must manually Get 
Mail or use the NEWMAIL command string.    
View new mail upon connect
Note that this option is dimmed so long as Get new mail upon connect is unchecked.   
If you don't get new mail, it isn't there to view.    If you do get new mail upon connect,
do you then wish to immediately view it (read the first new message)?    
Get new mail periodically
If this box is checked, the Message Center program running on your PC will 
periodically query the Worldgroup server to see if any new mail has arrived.    If there 
is new mail, it will be automatically copied to your In Box and a dialog box will appear
to tell you that new mail has arrived.    
Check every X minutes
Note that this option is dimmed so long as Get new mail periodically is unchecked.    If
you do want Message Center to periodically check for new mail, how often should it 
do so?    You can set it to check as often as once a minute (1) or as seldom as once 
every 32,766 minutes (about once every 23 days).    
Connect if necessary
Note that this option is dimmed so long as Get new mail periodically is unchecked.    If
it happens that Worldgroup Manager is on deck (running but not in contact with the 
Worldgroup Server) when Message Center is supposed to check for new mail, should 
Worldgroup Manager go online and attempt to connect to the Worldgroup server in 
order to check?    

If you check this box, so long as Message Center is running on your PC, whether or 
not at that moment it is online with the Worldgroup server, it will attempt to check for
new mail.    

If you leave this unchecked, Message Center will periodically check while you remain 
online but will not keep attempting to reconnect once you go on deck (obviously, 
once you exit Message Center and go completely offline, nothing will be left running 
which can attempt to check for new mail).    
Disconnect when done
Note that this option is dimmed so long as Connect if necessary is unchecked.    If 
Message Center ever has to attempt to go online in order to check for new mail, after
having done so should it go back to being on deck?    This is handy if online time is 



expensive for you, yet you need to remain accessible at all times.    You can set 
Message Center to check, say, every 30 minutes, then leave Message Center running 
but not connected to the Worldgroup server (on deck).    Every 30 minutes thereafter, 
Message Center will automatically attempt to go online, connect to the Worldgroup 
server, check for new mail, copy any new mail to your In Box, then go offline (back on
deck).    

A way to further automate this process is to run gcsvcman.exe (Worldgroup Manager)
at Windows Startup with command line parameters.    
The first parameter you'll need to specify is the Worldgroup server you want to 
contact.    You can specify it either by typing in the exact same text used in the icon 
label for that server, or (if a Telnet address) by typing host=domain.name
The second parameter you'll need to type is app=galmsg (telling it to run the 
application Message Center).    

The result of all of this is a command line that looks like

gcsvcman.exe    Label Under Server Icon    app=galmsg 
or
gcsvcman.exe    host=domain.name    app=galmsg 

Get attachments with mail
If this box is checked, any files attached to new mail will be downloaded to the 
directory you select below.    
Directory for attachments
Note that this option is dimmed so long as Get attachments with mail is unchecked.    
If you don't get attachment files, they don't arrive on your PC to be placed in a 
default drive:\directory.    You can manually type in a drive:\directory in the text box, 
or click Select.    
Select
Also dimmed so long as Get all attachments with new mail is unchecked, this lets you
choose what drive:\directory you want file attachments to go to by default.    

Post Office
Automatically get tagged mail upon connect
Prompt to get tagged mail upon connect
Don't prompt or get tagged mail
You can tag Post Office messages by checking the box to the left of each message.    If
any tags are present when next you connect, should Message Center immediately 
get those messages, ask first, or not get them?



Write Options

Sets defaults formatting choices like ruler dimensions, tabs, spell-checking, whether to 
assume plain or rich text, whether to quote by default, etc.

To reach this window, go to Message Center's Options menu and select Write.    

Formatted Messages
These settings apply to rich text formatted (.RTF) messages, not to plain-text 
messages.
Scale Units
When displaying rulers, should the measurement be in terms of inches, centimeters, 
or millimeters?
Default Tabs
When you press the Tab key while typing a rich text formatted message, you insert a 
single Tab character into the text.    This setting determines the distance between 
each default tab stop across the page    You can override this by explicitly setting tab 
stops of your own.

Plain-text Messages
This setting applies to plain-text messages, not to rich text formatted (.RTF) 
messages.
Tab Size
When you press the Tab key while typing a plain-text message, you insert spaces into
the text.    This setting determines how many spaces make up the distance between 
each tab stop across the page.    If you set this field to 8, then press the Tab as your 
first typing in this message's body, you'll insert 8 spaces.    If you type two letters 
then press Tab, only 6 spaces will be inserted so that the last space character is the 
8th on that line.    Press Tab again and the last space character will be 16th, then 
24th, etc., across the page.

General
Show recipients by default
If this box is checked, whenever you write a message, the message header's Show 
receipts box will default to checked.    

If this box is not checked, whenever you write a message, the message header's 
Show receipts box will default to not checked.    
Use message quoting by default
If this box is checked, whenever you Reply to any message, the message's contents 
will always be copied to your reply for you to edit and add comments to.    

If this box is not checked, whenever you Reply to a message, you'll be offered a 
button with which you can import the message's contents, or not, as you choose.    
Write plain-text messages by default
If this box is checked, whenever you write a message, the message header's Plain-
text box will default to checked.    

If this box is not checked, whenever you write a message, the message header's 
Plain-text box will default to not checked.    



Spell-check before sending
If this box is checked, whenever you attempt to send or post a message, the 
spellchecking program will first examine the text of your message.    

If this box is not checked, whenever you send or post a message, the spell-checking 
program will not    automatically examine the text of your message.
Save new addresses in address book
If this box is checked, every time you write a message to a new address, that address
will be added to your Address Book for future reference.    

If this box is not checked, you will have to manually update your Address Book.    
Always comment when forwarding
One of the options you have when forwarding/copying a message to some third 
person is that of inserting a comment at the beginning of the message ("Marc, you're 
probably the better one to handle this --Chris").    

If this box is checked, the comments window automatically comes up every time you 
copy or forward a message.    

If this box is not checked, you will still be able to click the Comments button on the 
Forward Message window.    
Delete original from in box after reply
One of the options you have when reading a message is to reply to it.    Once you've 
replied, do you want to retain the original message or have it automatically erased?    

If this box is checked, the original message will be automatically erased as soon as 
you either send or out-box the reply.    

If this box is not checked, the original message will remain in your In Box until you 
manually delete it.    

Auto-file
If this box is checked, every message written by you will be automatically filed in the 
Filing Cabinet in the folder you choose from the dropdown list, unless you override 
this in each message's header.    

If this box is not checked, messages will not be automatically filed.    You can then 
manually file those messages you wish to file by clicking the Options button on the 
Write New Message / Editing Message window.    
File when sent in
If this box is checked, the message will be automatically copied into the Filing Cabinet
only when you send the message to the server.    

If this box is not checked, the message will not be automatically filed.    



Font Options

Sets default fonts and sizes for plain and rich text, display of plain-text messages received, 
etc.

To reach this window, go to Message Center's Options menu and select Font.    

Font to set
Message Center divides rich text formatted messages into several styles.    Either 
double-click one of these, or single-click it and click Select.    

Select
Brings up the standard Windows Font dialog box to let you define this style's font 
characteristics.



Font

This is where you define the font characteristics of a particular style of text in Message 
Center.

Font
The typefaces listed are those which are available in your installation of Windows.    
See the Windows' Control Panel Fonts icon for more details.    Be aware that the set of 
fonts on your PC are unlikely to be identical to the set on the recipient's PC.    Faced 
with a message asking for a font which is not available, Message Center will select 
what it feels is the closest match to that font.    The more unusual the font, the less 
likely Message Center will be able to find a suitable substitute.    Fonts generally found
on all Windows PCs include MS Serif, MS Sans Serif, System, Helv, Courier, and our 
own Galacticomm font.    

Font Style
This varies with different fonts, but in general you can set the text to be italic, bold, 
bold italic or regular.    

Size
Print size is measured in points.    One point is 1/72nd of an inch.    On most systems, 
the text you are now reading is 10 point.    The title "Size" above this paragraph is 12 
points.    

Effects
Text can also be underlined and struck out.      

Color
 You can make different types of text different colors.    



Out Box Options

Sets whether to immediately send messages from the Out Box upon connecting to the 
Worldgroup server, prompt you, or not send until you manually click Send.

To reach this window, go to Message Center's Options menu and select Out Box.    

Out Box
Automatically send all upon connect
If this is selected, as soon as you are both online and running the E-mail client app, 
all messages in your Out Box will immediately be sent to the server.    
Prompt to send all upon connect
If this is selected, as soon as you are both online and running the E-mail client app, 
you will be asked if you wish to begin sending all messages in your Out Box to the 
server.    
Don't send or prompt upon connect
If this is selected, you will have to manually Send your mail.    



Server Options

Most options are set locally on your PC's hard disk.    Some, though, must be recorded on the 
Worldgroup server.    Although this dialog box can come up without first going online, in order
to save changes you make here you will have to go online.

To reach this window, go to Message Center's Options menu and select Server.    

Auto-forward mail to
In the same way some telephone lines can be call-forwarded to another telephone 
number, you can auto-forward all mail addressed to your User-ID to another User-ID 
or exported e-mail address.    Some users wish to maintain multiple accounts but 
check for mail on only one.    Alternatively, it's handy to forward your work mail to a 
coworker when you go on vacation.    You can either type in a User-ID in the text box, 
or click the Address Book button to look one up.    

 
Note that this button is dimmed so long as Auto forward mail to is unchecked.    If you 
don't plan to auto-forward your mail, there's no point in looking up a forwardee's 
address entry.    

Show forum messages to you in E-mail
If this box is checked, any messages placed in a forum but addressed to your User-ID 
will be handled as if they were e-mail messages addressed to you.    They will be 
delivered to you when you Get Mail.    

If this box is not checked, messages placed in a forum, even if they are addressed to 
your User-ID, will not be considered as e-mail.    

Delete original from post office after reply
One of the options you have when reading a message is to reply to it.    Once you've 
replied, do you want to leave the original message in your Post Office box on the 
Worldgroup server or do you want to have it automatically erased?    

If this box is checked, the original message will be automatically erased as soon as 
you either send or out-box the reply.    

If this box is not checked, the original message will remain in your Post Office box 
until either you manually delete it or its age exceeds the message lifetime (set by the
Sysop) and it's automatically erased.



Forward Message

Sends this message on to a third person, optionally with a comment from you, optionally 
erasing your copy of the message.    

To reach this window, go to the Reading a Message window and either click the Forward 
toolbar button or pull down the File menu and select Forward.    

To forward all of the mail arriving for this User-ID to another User-ID, go to Message Center, 
pull down the Options menu, and select Server.    

To
The User-ID or e-mail address to whom you wish to send this message.    You can 
either type one in from memory or click the Address a Message button.    

Delete original
If this box is checked, as soon as the message is copied to the To address, your copy 
will be erased.

If this box is not    checked, your copy of the message will not    be erased when the 
message is copied to the To address.

 
Brings up the Address a Message window and lets you insert a User-ID or e-mail 
address from its entries.    

Send
Copies this message to the To address, going online to do so if not online already.

Out Box
Copies this message to the To address but stores it locally on your PC awaiting a Send
(or Edit) in the future.    No attempt is made to go online.

Comment
Lets you place a comment ahead of the original message's text as an explanation for 
the person to whom you're forwarding the message.    



Comment on Message

When forwarding/copying a message, this lets you place a comment ahead of the original 
text as an explanation for the third person receiving this message.

To reach this window, go to the Forward Message window and click Comments.    

To
Who the forwarded or copied message will be going to.    

From
The original sender of the message (not you but the person who sent it to you).    

Topic
A brief description of the subject of the original message.    

Comments
Type whatever comment you wish here.    The text you type here will be inserted 
ahead of the text of the original message.    



Details on the <forumname> Forum

This provides more information on a particular forum.    

To reach this window, go to the Select a Forum window and click Details.    

Forum-Op
The User-ID of the person responsible for maintaining/monitoring this forum.    

Topic
The short description of the subjects which ought to be discussed in this forum.    It is 
considered polite to keep conversations fairly close to the stated topic(s).    The 
occasional aside is acceptable, but a long thread on a completely unrelated topic has 
been known to annoy other users.    

Messages
The current number of messages in this forum.    

Threads
The current number of conversation threads in this forum.    

Files
The total number of files attached to messages in this forum.    

Message lifetime (days)
To keep the size of a forum from spiraling out of control, a message is automatically 
erased from the forum after this number of days passes from the day it was originally
posted to the forum.    

Credit Issues
If you are not charged for the use of this Worldgroup, these next seven items will 
have no effect on you or your user account.    
Charge per message posted
The number of credits which will be deducted from your balance when you send a 
message to this forum.    
Charge per file upload
The number of credits which will be deducted from your balance when you post a 
message with a file attached.    
Charge per k-byte upload
The number of credits which will be deducted from your balance for each kilobyte 
(1024 bytes) taken up by a file attached to a message you post to this forum.    
Charge per message read
The number of credits which will be deducted from your balance when you read or 
get a message from this forum.    
Charge per file download
The number of credits which will be deducted from your balance when you download 
a file attached to a message in this forum.    
Charge per k-byte download
The number of credits which will be deducted from your balance for each kilobyte 
(1024 bytes) taken up by a downloaded file attached to a message in this forum.    



Detailed Information
A more in-depth explanation of this forum's purpose and goals.    It is optional.    



Attach A File

This lets you select a file from one of your PC's drives to attach to the message you're 
currently writing or editing.    When you send the message, a copy of this file will be 
uploaded to the server.    When the recipient gets the message, he or she can then download
the file.    

File Name
The text box lets you manually enter the drive:\directory\...\filename.ext of the file 
which you wish to attach to this message.    

The standard list box below the text box displays all files in the current drive:\
directory.    

The fastest way to select a file, once it's visible in the list box, is to double-click it.    

Directories
The list box displays the directory tree of the drive:\ selected below in Drives.    The 
current directory is the one whose folder icon is open and darkened within.    Any 
folders listed below it are children subdirectories of the current directory.    Any folders
listed above it are parent directories.    Between the list box and the title line 
Directories: you will see displayed in text the current directory's drive:\path, 
possibly abbreviated.    

Double-click on a directory to switch to it.    If the directory you seek is not visible, 
double-click on the directory which you know to be its parent.    This list box does not 
display the entire tree at once, but limits itself instead to the parentage and children 
of the current directory.    

Drives
This dropdown list box selects the drive letter you wish displayed.    Depending on 
your PC's setup, it may display volume names in [brackets] to the right of each drive 
letter.    

A single click selects a drive letter.    The Directories and File Name list boxes will 
change to display the new drive's current directory and files.    



Select Download Directory

This sets where you want to put files attached to e-mail or forum messages.    This is the 
equivalent of your In Box, but for files instead of for message text.    

To reach this window, go to the Get Messages for Offline Use window, place a check in the 
Include attachments checkbox and click Select.    

Directories
The list box displays the directory tree of the drive:\ selected below in Drives.    The 
current directory is the one whose folder icon is open and darkened within.    Any 
folders listed below it are children subdirectories of the current directory.    Any folders
listed above it are parent directories.    Between the list box and the title line 
Directories you will see displayed in text the current directory's drive:\path, possibly
abbreviated.    

Double-click on a directory to switch to it.    If the directory you seek is not visible, 
double-click on the directory which you know to be its parent.    This list box does not 
display the entire tree at once, but limits itself instead to the parentage and children 
of the current directory.    

Drives
This dropdown list box selects the drive letter you wish displayed.    Depending on 
your PC's setup, it may display volume names in [brackets] to the right of each drive 
letter.    

A single click selects a drive letter.    The Directories list box will change to display the
new drive's current directory.    



File Exists: Overwrite, Append, Reselect?

When saving message text to a file, if you specify a file which already exists, what do you 
wish to do:

Overwrite
Erases the current contents of the file and replaces it with this message's text.    

Append
Preserves the current contents of the file and adds this message's text to the end of 
the file.

Reselect
Returns you to the Save window so you can specify a different filename.

 



Download a File

You've just requested that a file be downloaded from the Worldgroup server to your PC.    You
can either immediately download the file or simply tag it to be downloaded later.    This 
window sets the drive:\path\filename.ext where you wish the file to be placed on your PC, 
and sets whether you want the file to be automatically opened/run once it arrives.    

In either event, the request is sent to the Download Manager (part of the Worldgroup 
Manager program) which will keep track of the request until either the file is downloaded or 
until you delete the request.    

Download Now
Adds this file to the Download Manager's list.    If no other download is currently in 
progress, it will be assigned a status of Downloading (or Launching) and begin 
transferring the file to your PC.    

Download Later
Adds this file to the Download Manager's list but assigns it a status of Waiting for 
Download (or Launch).    The request will remain suspended until you open Download 
Manager and either delete the request or set it to download/launch.    

Launch File
If this box is not    checked, the file will simply be downloaded.    

If this box is    checked, once the file arrives on your PC it will be immediately 
opened/run using whatever Windows application is associated with the extension on 
this filename.    

For example, if .TXT is associated with Wordpad on your PC, checking Launch File 
when downloading any filename.TXT will cause Wordpad to be run, automatically 
opening filename.TXT into it for viewing/editing.    

File Name
The text box presently suggesting the filename.ext by which the file is stored on the 
server.    You can manually enter the entire drive:\directory\...\filename.ext if you wish.

You are welcome to save the file on your PC under a different filename, but you 
should leave the extension the same.    For example, if the file is labeled 
<something>.zip on the server, it's most likely been compressed using PKzip.    Even if 
you save it to <something>.bat on your PC, the file itself will still be a zip and you'll 
have to explain the unexpected extension (.bat) to PKunzip in order to uncompress 
the file.    

The standard list box below the text box displays all files in the current drive:\
directory.    This helps you avoid name collisions.    

Of course, you may want to save the new file over top of an existing file.    In that 
case, you can save yourself a few keystrokes by double-clicking on the file you wish 
overwritten.    



Directories
The list box displays the directory tree of the drive:\ selected below in Drives.    The 
current directory is the one whose folder icon is open and darkened within.    Any 
folders listed below it are children subdirectories of the current directory.    Any folders
listed above it are parent directories.    Between the list box and the title line 
Directories: you will see displayed in text the current directory's drive:\path, 
possibly abbreviated.    

Double-click on a directory to switch to it.    If the directory you seek is not visible, 
double-click on the directory which you know to be its parent.    This list box does not 
display the entire tree at once, but limits itself instead to the parentage and children 
of the current directory.    

Drives
This dropdown list box selects the drive letter you wish displayed.    Depending on 
your PC's setup, it may display volume names in [brackets] to the right of each drive 
letter.    

A single click selects a drive letter.    The Directories and File Name list boxes will 
change to display the new drive's current directory and files.    

 



Glossary

The following definitions are available:

Bitmap File
C/S (Client/Server) Mode
Client Side
Dumb Terminal
File Transfer Protocol
Metafile
Online, Offline, On Deck
Password
Worldgroup server
Server Side
Sysop
Terminal Mode
User Account
User-ID



Bitmap File
A bitmap is a way to store a graphical image as a rectangular grid of dots (pixels).    

For example, this is a bitmap graphic:    

Here it is again 4 times as 
large.    Bitmaps don't enlarge 
very well because the 
information that is stored 
within them is only accurate 
down to the size of a single 
pixel (dot).    Enlarge a bitmap 
and you get big dots.      

On the other hand, bitmaps work very well when they store information which is not meant 
to be enlarged, reshaped or otherwise manipulated.    Windows icons are bitmaps (stored as
.ico files or embedded in .exe files).    Windows wallpaper designs are bitmaps (.bmp).    

The Windows program Paintbrush can manipulate .bmp files.    

See also Metafile.    



C/S (Client/Server) Mode

Two-sided computing: your PC and the Worldgroup server PC both work to satisfy your 
requests.    Your PC's processing power is not ignored (as with a terminal mode BBS).    In fact,
your PC ends up doing most of the work.    C/S mode minimizes wasted time online by letting
you do many tasks on deck.    

Client/server means that one program (the client) can ask another program (the server) for 
assistance.    The two programs often run on separate computers connected by a 
communications link (a network, the telephone system, etc.).    

WGM is a client program running on your PC.    

The Worldgroup server is a server program running on a remote PC.    



Client side
Your PC running WGM is the client side of a client/server relationship.    The remote PC 
running Worldgroup server software is the server side of the relationship.    The term client 
side includes:

1) any programs which run on your PC
2) any data, documents, or other files which are stored on your PC

The client side can do many tasks itself, and calls on the server side for tasks it cannot do 
(exchanging messages with other clients, looking up centralized information, etc.).    



Dumb Terminal
A device which has a keyboard, a monitor, possibly a mouse, but has no ability to process 
data by itself.    A dumb terminal has to be connected to a computer in order to do anything.  

Old-style user-side modem programs are known as terminal programs because they make 
your PC mimic a dumb terminal (thereby wasting your PC's processing power).    



File Transfer Protocol
A language for exchanging files between two computers and confirming that what arrives is 
the same as what was sent.    Common protocols for terminal-mode transfers include 
ZMODEM, XMODEM, YMODEM-Batch, and Kermit.    

WGM in C/S mode uses its own information transfer protocol, GCSP, which uses Dynapaks to 
exchange all forms of data including files.    



Metafile
A metafile is a way to store a graphical image as a collection of shapes, angles, and relative 
distances.    

For example, this drawing is a metafile:    

Here it is again 8 times 
as large.    Note that its 
curved edges are far 
smoother than would 
be a bitmap of the 
same size.    Stretched 
large or small, a 
metafile is recalculated
to provide the most 
accurate image 
possible.    

Because PC monitors in use today may be set to any of a dozen different resolutions (so 
many pixels tall, so many pixels wide), we have used metafiles within WGM's help files 
wherever possible.    This makes it more likely that graphics will appear properly on your 
display.    

The Windows program Paintbrush cannot manipulate .wmf files.    

See also Bitmap File.    



Online
Connected.    
Your PC is online whenever it is connected to a Worldgroup server.    

Offline
Disconnected.    
Your PC is offline whenever it is not connected to a Worldgroup server.    

On Deck
Disconnected but able to perform tasks.    
Your PC is on deck whenever WGM is running the client-side program for a 
Worldgroup service but your PC is not yet connected to the online service.    



Password
The private half of your identification, seen only by the Worldgroup server software and the 
Sysop.    

A password is the confirmation that you are who your User-ID says you are.    Without 
passwords, someone else could log on using your User-ID and do things that you would be 
blamed for.    Keep your password secret.    

Avoid obvious, easily guessed, passwords.    Make up something that is not your mother's 
maiden name, not your job title, in fact not anything related to your work.    

Don't use a completely random string of characters, though.    "NE1410S" will be hard to 
remember.    Instead, an effective middle choice is to run two words together which are 
easily remembered by you but not easily guessed by others.    "Twosun" for example.    



Worldgroup Server
Any online service running Worldgroup server software by Galacticomm, Inc.    

Online services running other software are not servers in the client/server sense.    WGM 
drops back to terminal mode in order to communicate with them.    



Server side
The remote PC running Worldgroup is the server side of a client/server relationship.    Your PC
is the client side of the relationship.    The term server side includes:

1) any programs which run on the Worldgroup server PC
2) any data, documents, or other files which are stored on the Worldgroup server PC

The server side exists solely to do tasks which the client side cannot do itself (exchanging 
messages with other clients, looking up centralized information, etc.).    



Sysop
A System Operator, or Sysop, is the manager of a Worldgroup system.    



Terminal Mode
One-sided computing: the software running on the remote computer insists on doing all of 
the work, so the user's PC might as well be a dumb terminal.    This mindset made sense 
when computing power was prohibitively expensive.    Today, though, your PC may well be 
more powerful than the PC running the online service you call.    Even if it isn't, your PC is 
closer to you than the service's PC.    It can do things without delay, if the software at both 
ends permits.    Client/server mode permits this.    Terminal mode does not.    

WGM falls back from C/S mode to terminal mode in order to communicate with non-
Worldgroup online services.    



User Account
A list of information including your full name, your mailing address, your telephone number, 
etc.    In a for-profit online service, the user account may include your credit card number or 
other method of payment.    

User account information is private, seen only by you and by the Sysop.    

Your user account is identified by your User-ID and password.    



User-ID
The public half of your identification, seen by the software and by other users.    

A User-ID is a string of 3 to 29 characters.    On business systems, it is often your full name.    
On social systems, it is often a nickname or "handle."    In some situations, a User-ID may be 
assigned to you, but in most cases you have creative control.    

Your User-ID is verified by the password you associate with it.    



I never metafile I didn't like
            (Stryker said I could do it! --Marc)
 



Print
This function sends data to your printer.    It suggests Number of copies: 1 but will accept as 
many as 999.    From this point on, Windows takes over.    

If you simply click on OK (or press Enter), Windows will print the data on whatever default 
printer you've set in Control Panel's Printers area.    

If you click on Setup..., Windows will first bring up the printer setup window which will let you
choose which printer (or file) will receive this data.    

 



Open
This function helps you locate a file on your PC and load it into the program you are currently
running.    

Of course, the file has to be of a type which is meaningful to the program.    For example, you
can try to load a text file into File Libraries when it asks for a saved list.    However, it won't 
know what to do with the text file because it isn't in the expected format (.gfl).    

File Name
The text box lets you manually enter the drive:\directory\...\filename.ext of the file 
which you wish to open.    

The standard list box below the text box displays all files in the current drive:\
directory which are of the type selected by List Files of Type.    

The fastest way to select a file, once it's visible in the list box, is to double-click it.    

List Files of Type
The dropdown list box lets you limit the files displayed under File Name to those of a 
particular type.    This is helpful when a program can make use of only one type of 
file.    If List Files of Type doesn't offer the filter you require, you can manually enter 
your own under File Name.    

For example:

° Text files are often *.txt.
° Word processor documents are often 

*.doc.
° DOS Batch files are *.bat.    
° Programs are either *.com (command) or 

*.exe (executable).    
° Common Windows graphics formats are 

*.bmp (bitmap) and *.wmf (metafile), 
although there are more than a dozen 
other popular graphics formats.    

° The File Libraries module can save a file 
listing to your PC as *.gfl.    This can be 
opened by File Libraries while you are 
offline, letting you examine a library's 
"card catalog" without being online.    

Other forms of data will come with extensions appropriate to them.    The normal 
default is to *.* for all files.    

Directories
The list box displays the directory tree of the drive:\ selected below in Drives.    The 
current directory is the one whose folder icon is open and darkened within.    Any 
folders listed below it are children subdirectories of the current directory.    Any folders



listed above it are parent directories.    Between the list box and the title line 
Directories: you will see displayed in text the current directory's drive:\path, 
possibly abbreviated.    

Double-click on a directory to switch to it.    If the directory you seek is not visible, 
double-click on the directory which you know to be its parent.    This list box does not 
display the entire tree at once, but limits itself instead to the parentage and children 
of the current directory.    

Drives
This dropdown list box selects the drive letter you wish displayed.    Depending on 
your PC's setup, it may display volume names in [brackets] to the right of each drive 
letter.    

A single click selects a drive letter.    The Directories and File Name list boxes will 
change to display the new drive's current directory and files.    
 



Save / Save As
This function lets you record information to a disk file on your PC.    

File Name
The text box lets you manually enter the drive:\directory\...\filename.ext into which 
you wish to save the information.    Set the appropriate file type in Save File as Type.    

The standard list box below the text box displays all files in the current drive:\
directory which are of the type selected by Save File as Type.    

If you wish to save over top of an existing file which is visible in the list box, you can 
double-click on it, or highlight it then click on OK.    

Save File as Type
The dropdown list box lets you choose the way you wish the information to be 
recorded in the file.    

For example:

° Text is usually saved as .txt (ASCII text).    
° DOS Batch files are usually saved as .bat. 

Text and Batch files can be safely viewed.   
The following file types are machine 
readable only and so should not be viewed
as text:

° Programs are usually saved as .com 
(command) or .exe (executable).    

° Graphics are often stored as .bmp 
(bitmap) or .wmf (metafile).    

° Files are often compressed and packaged 
into a single file for quicker and simpler 
delivery.    Such compressed packages are 
most commonly stored as .zip (PKware 
format).    In order to extract a zipped file's
contents, you need the program 
PKunzip.exe.    

° The results of searches in File Libraries 
should be saved as .gfl (Galacticomm's 
file library format) if you wish to use the 
list to tag files to be downloaded.    

Other forms of data will come with choices appropriate to them.    

Directories
The list box displays the directory tree of the drive:\ selected below in Drives.    The 
current directory is the one whose folder icon is open and darkened within.    Any 
folders listed below it are children subdirectories of the current directory.    Any folders
listed above it are parent directories.    Between the list box and the title line 



Directories: you will see displayed in text the current directory's drive:\path, 
possibly abbreviated.    

Double-click on a directory to switch to it.    If the directory you seek is not visible, 
double-click on the directory which you know to be its parent.    This list box does not 
display the entire tree at once, but limits itself instead to the parentage and children 
of the current directory.    

Drives
This dropdown list box selects the drive letter you wish displayed.    Depending on 
your PC's setup, it may display volume names in [brackets] to the right of each drive 
letter.    

A single click selects a drive letter.    The Directories and File Name list boxes will 
change to display the new drive's current directory and files.    
 



Find...
This function helps you find the correct spelling of a person's User-ID.    

Although people commonly use their full names as User-IDs, you need to remember that a 
User-ID is a single string.    That is, the User-ID "Carolyn G." will appear before the User-ID 
"Kelly B." because the letter C comes before the letter K.      

Type your best guess in the User: field    
As with almost everything in Worldgroup, UPPER/lower case doesn't matter:    "Tyler" 
equals "TYLER" equals "tyler".    

Click on the Search button    
If the function finds any matches, the window will enlarge to display a list of possible 
matches.    Select the one you wish either by double-clicking it, or by single-clicking it 
then clicking the OK button.    The selected User-ID will be returned to the window 
from which you called Find...    

If the function does not find a match, try a shorter string in the User: field.    Although 
you can type in a full name, it's generally better not to.    If you ask for "reginald" but 
he signed up as "Reggie", the search won't find him.    You're better off searching for 
"reg".    

Notice that you can search for a person by last name, or even partial last name.    It 
will not find "Ann Owen" if you type in "we", however.    The search string in User: 
must be the beginning of a word if not a whole word.    



Edit Toolbar

This window lets you choose which buttons are displayed on the toolbar and which are not.    
Notice that not all of the buttons you add will necessarily appear immediately after you save
your edits.    It may be inappropriate to display a particular button at this moment but, when 
it becomes appropriate, the button will be displayed.    

Add/Remove a Button
A single mouse click on any of the buttons listed here, or on the description beside it, 
will toggle between displaying the button on the toolbar and not displaying it.    
Highlighted means the button has been included/added to the current toolbar.    Not 
highlighted means the button has been excluded/removed from the current toolbar.    

Add All
This button highlights every button in the list, including/adding all of them.    

Remove All
This button unhighlights every button in the list, excluding/removing all of them.    

Save
Once you've edited this toolbar to your satisfaction, click this button to save your 
changes.    Not all of the buttons you add will necessarily appear immediately.    It may
be inappropriate to display a particular button at this moment but, when it becomes 
appropriate, the button will be displayed.    

 




